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Learning Objectives 
• Learn how to choose the ideal projection systems for geo-spatial data exchange 
• Learn how to create custom coordinate systems for exchanging data between single- and 

double-precision CAD and design applications 
• Learn how to create and modify simple scripts for translating data inside AutoCAD and AutoCAD 

Civil 3D 
• Learn how to prepare CAD assets for export and consequently bring the resulting models back 

to CAD in the correct geo-spatial location 

Description 
Working with data sets between single-precision, non-geospatially aware applications (such as 3ds Max 
software, Revit software, and Inventor software) and double-precision, geospatially aware applications 
(like AutoCAD software, AutoCAD Civil 3D software, InfraWorks software, ReCap software, and 
Navisworks software) can be difficult and frustrating. This class will help you to better understand this 
confusing process and explore several effective and proven methods for exchanging data sets between 
these applications with a minimal loss of production time. 

Your AU Expert 
Mark Kauffman’s animation career stretches back to the wild and wooly days of the early 1990s. In 1995, 
he co-founded Paradigm Ranch Animation Studios, working on movie and television projects. In 1998 
Mark joined the faculty at The Art Institute of Colorado, training students in the animation, graphic 
design, web, industrial design, and video programs until he left in 2012. In 2003 he joined the Project 
Visualization Group at WSP |Parsons Brinckerhoff (WSP-PB), serving as the team’s technical lead. As 
lead, he manages all technical aspects of production, manages the render farm, and oversees the group’s 
research and development and new technology initiatives. In addition to his duties with the Project 
Visualization Group, Mark serves as a certified 3ds Max software trainer in WSP-PB’s Autodesk Training 
Center, and he is the president of the Colorado AAUGA group, and a founding member of the 
Visualization Society of Colorado.   
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Introduction 
I have worked in the design visualization field since 2003 (12 years), specifically building 3D models used 
to visualize civil engineering projects such as highways, bridges, rail corridors and transportation hubs 
and the one aspect of our production workflow that has caused the most pain is exchanging datasets 
between geospatial/double precision applications such as Civil3D, Microstation and ArcGIS; and single 
precision applications such as 3ds max. In fact, this process of data exchange, which I like to call “The 
Geospatial Boogie”, represents a significant amount of (wasted) time within our workflow.  

Interestingly, as time went by, I began to realize this was not entirely unique to my organization. Not 
only was this affecting my follow design visualization artists, but many of the engineers and architects 
outside of my company. Most of these people had developed interesting workflows to facilitate the 
exchange of data between the various design visualization and engineering applications, but most were 
clunking, highly inaccurate and, well, broken.  

Over several years, we have devised an effective workflow to transform and exchange data between 
single and double precision coordinate spaces. The focus of this class and accompanying materials, is to 
explain in a simple but effective manner the differences between single and double precision coordinate 
systems, how geospatial data is utilized and exchanged, and finally, present a process by which you can 
translate and exchange these datasets with a minimal amount of trouble and a minimal amount of data 
degradation.  

What is the Significance of Single and Double Precision Data? 
Most CAD applications such as Autocad and Microstation are designed to use double precision floating-
point calculations, a 64-bit value, to explain the location of a point in 3 dimensional space. 3ds max, 
Revit and Sketchup, on the other hand, are designed to utilize single precision floating-point 
calculations, a 32-bit value, to explain the location of a point in 3D space.  Ultimately, the differences 
between single and double precision calculations in each application come down to the number of 
significant digits used to represent a value.  

For instance, a single precision value can be represented by 9 significant decimal digits with the decimal 
point moving to the left or right of the first digit (Figure 1): 

 

In the case of double precision, a value can be represented by 17 significant decimal digits (Figure 2): 

Figure 2 

Figure 1 
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That last number represents a point in 3D space with an accuracy of .1 inches in a space equal to 
2,338,196,778 miles or 3,762,962,955 km. That is almost the distance of the Sun to Neptune! 
For 3ds Max and Revit, this means a value used to represent a point, vertex or polygon center within 
3 dimensional coordinate space, will be registered using a 9 digit number for x, y and z.  Thus, as a point 
gets further away from the coordinate space origin (0,0,0 in x,y,z) the level of accuracy decreases 
relative to the location of the decimal point in the coordinate value. 
 
If you take into account your system unit scale (i.e. inch, foot, millimeter, meter, etc.), you will lose an 
additional decimal point in accuracy. A great way to demonstrate this effect is to open up 3ds max, 
create a 10ft square rectangle at the local origin of 0,0. Now, translate the rectangle to 1,500,000 by 
1,500,000. Add an edit spline modifier to the rectangle, enter sub-object vertex mode and try to 
translate a vertex. You will notice that it “jumps” around when trying to move (Figure 3).  

  
Figure 3 
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Geospatial Basics 
The next aspect of this equation is the geospatial factor. So what is geospatial and what is the 
significance of single and double precision data? Well, to start, let’s talk about double precision data.  

First, you will remember from earlier, a double precision value can explain a point in 3D space with a 
reasonable level of accuracy between the Sun and Neptune. Well, with that level of precision and 
distance, we could explain a point in 3D space with extreme accuracy anywhere on good old Planet 
Earth with many decimal places to spare.  

Next, we need a model with which to explain 3D points on a map of earth, but also a method to address 
a little spatial problem we rarely even acknowledge due to our perception of our environment. That 
little spatial problem is the size of the Earth and its resulting shape, which is nearly impossible to 
perceive from our vantage point on the ground. As the Greek mathematician Eratosthenes proved and 
Christopher Columbus demonstrated a mere 1700 years later, the world is in fact not flat, but a globe.  

Have you ever noticed when you view a flat picture of our planet, all the land masses at the north and 
south Polar Regions are rather large compared to the other continents (Figure 4)?  

  

Figure 4 
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Man, Greenland is rather large compared to the entire continent of North America! This map is a 
Mercator Projection of Earth where the north and south polar regions are stretched to account for the 
spherical shape unwrapped or “projected” from a central point out to a flat surface. Here is an example 
(Figure 5):  

Projections and Datums 
A Projection, is essentially the process of projecting a non-flat surface (the Earth) onto a flat surface such 
as a map. Consequently, there is always some distortion involved in this process, but the resulting math 
is able to accurately explain this process to a Global Information System (GIS), but more on GIS in a little 
while. There are several types of projection systems, which I will describe in brief: 

• Mercator- A conformal, cylindrical projection tangent to the equator 
• Transverse Mercator - Similar to the Mercator except that the cylinder is tangent along a 

meridian instead of the equator 
• Universal Transverse Mercator (UTM) – Based on a Transverse Mercator projection centered in 

the middle of zones that are 6 degrees in longitude wide 
• Lambert Conformal Conic – A conic, conformal projection typically intersecting parallels of 

latitude, standard parallels, in the northern hemisphere. 
• State Plane – A standard set of projections for the United States based on either the Lambert 

Conformal Conic or transverse Mercator projection, depending on the orientation of each state 

While it is not important to remember each type of projection system, you might recognize two variants 
immediately if you ever work with geospatial datasets, specifically State Plane and Universal Transverse 
Mercator (UTM). Most civil engineering projects will use a projection system that minimizes the amount 
of distortion.  

Datum on the other hand explains coordinate spaces in a vertical space relative to the center of the 
planet. This takes into account not only the lat/long coordinates, but the ellipsoidal shape of the Earth. 
Yeah, Earth is not a perfect 10, having a lumpy uneven shape with a bulge at the equatorial section 

Figure 5 
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(don’t worry dear, I still love you anyway). The Datum takes this ellipsoidal data along with the Mean 
Sea Level at the lat/long position and the gravimetric readings, does some wicked math and comes up 
with a model often seen as NAD83, WGS84, and NAV98 to name a few. Confused yet? 

Geographic Information Systems (GIS) 
Looking up a definition in Wikipedia lists GIS as “a system designed to capture, store, manipulate, 
analyze, manage, and present all types of spatial or geographical data.” A GIS program uses the Data 
and Projection information assigned to a myriad of datasets to ultimately align everything into a master 
database comprising a specific location or the entire world.  

While the majority of geospatial datasets are double precision with associated coordinate information 
(projections and datum) to explain where the data should be located, single precision datasets can also 
contain coordinate data. It is the function of the GIS program to align these disparate datasets to a 
common system.  

Custom Coordinate Systems 
As I stated earlier, single precision datasets can retain coordinate data, though it is almost always based 
on a custom coordinate system. These are created using a base projection and datum system, usually 
based on the master coordinate system from a project. Some custom coordinate systems are created for 
double precision data as a means to address specific project requirements. We will look at one of those 
later and how it can throw your workflow into chaos, but for the purposes of this presentation, we will 
focus on custom coordinate systems for single precision datasets.  

While you can do a simple translation from a double precision space to a single precision space, there is 
one important factor to consider, projection and datum. If you remember, a projection is a 
mathematical model which explains how to project spatial data from a curved surface to a flat surface. 
You will remember in the image earlier showing a Mercator projection of Planet Earth, the north and 
south regions were distorted. Similarly, if you were to translate a point in coordinate space (double 
precision) to a point in local coordinate space (single precision) without taking into account the 
projection information, you might experience a slight rotation and skew to your data. Here is an 
example (Figure 6):  
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This is Colorado State Plane Central Zone in Meters using the HPGN Datum (High Precision Geodetic 
Network). As you can see, the normally straight edged rectangular section is bowed at the top and 
bottom. That red dot in the center is the central reference for the projection (not 0,0) where the least 
amount of distortion occurs. State Plane Coordinate systems are usually broken up into zones to 
minimize this distortion effect. While Colorado requires 3 zones (North, Central and South) a larger state 
like California, Texas or Alaska require many more (CA 6, TX 5, AK 10). A smaller state like Rhode Island 
or South Carolina require only 1.  

To create a custom coordinate system for my project in Denver, CO for use in 3ds max, I would start 
with the above mention projection and datum, and using a set of tools which we will cover a little later, I 
would assign a transformational shift from the project space to a local space. In this case, the point 
referencing 997882.7526, 497121.9354 would be reprojected to 0,0. This way, all of the content I will 
create in 3ds max will not experience precision problems. As I export this content created in 3ds max 
into one of my project applications, I have a reference to get it back to the correct geospatial location.  

  

Figure 6 



Effective Coordinate Space Transformation Workflows 

 
 8 

 

The Process 
Ok, so let’s get to the meat of the dog and pony show. I will break this process down into specific parts 
using an existing project and walk you through the steps of configuring your data and exchanging it. For 
this presentation, I will be focusing on 3ds max primarily, but many of these processes will also address, 
Autocad, Civil 3D, Revit, Recap, InfraWorks, Navisworks, and Microstation. Additionally, I will be using an 
application which was become a pivotal tool in my production arsenal for working with GIS datasets; 
Global Mapper.  

Degradation of Data 
To start, I would like to demonstrate some of the pitfalls associated with the exchange of data between 
single and double precision coordinate system, specifically the degradation of your dataset. The first 
example, direct import of a double precision dataset, demonstrates very succinctly what can happen to 
your data if not translated in a double precision environment first.  

 In this example, I have a surface created in Civil 3D and imported directly into 3ds max (File>Import-
DWG). The starting surface in Civil 3D is clean and the edges are straight relative to the model (Figure 7)  

 

  

Figure 7 
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Figure 9 

As this DWG is imported into 3ds max, it appears in the same area as it did in Civil3D, but you will notice 
some serious degradation to the model in 3ds max (Figure 8). This is due to the way points are handled 
in single precision, resulting in rounding errors.  

The second example is very similar to the first, but I used the Global Import Shift 
function in Civil View to translate the CAD to a location close to 0,0 (Figure 9). Civil 
View is still functioning inside the 3ds max environment and therefore is using 
single precision for all translations, resulting in precision errors to the imported 
data. Even worse, Civil View only works in integer values and not float (not 
decimals), which can be a big problem if your translation exchange point is based 
on a survey point which will often have a decimal value.  

  

Figure 8 
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Data Exchange Methods 
As I stated earlier, I have come up with many methods for exchanging data between single and double 
precision coordinate spaces which I will demonstrate below. Before I start, I highly recommend you 
create an informational file which you can refer to throughout the cycle of your project. This simple text 
file will contain the flowing information: 

1. Project Coordinate System – This is the projection and datum used for the project. For example, 
Colorado State Plane Central Zone, Feet HPGN Datum.  

2. Translation Reference Point, Project Space in Project Scale – This is a point which you have 
chosen in the project to represent 0,0 in your single precision application in either feet or 
meters.  

3. Translation Reference Point in the opposite Project Scale – In this case, it is always good to 
have your reference point in a unit scale that is the opposite of item 2. For instance, if item 2 is 
in feet, provide a version in meters. 

4. Project False Easting and Northing – Each projection system uses a false easting and northing 
value. This will become useful once you start creating your own custom coordinate system. 

5. Custom False Easting and Northing – This is the value you will use to create your custom 
coordinate system and is a value based on the subtraction of item 2 above from item 4. 

6. Custom Coordinate Space – This is the name of your custom coordinate space 

Method 1 – Autocad Script 
This first method is by far the easiest, but by no means the best. It involves a simple translation script in 
Autocad or any of its derivatives, which selects everything in your file and translates it to 0,0. The script 
is a simple single line of information which tells Autocad to select everything, move it from a reference 
point in double precision space to 0,0. You would then save your DWG, preferably with a new name 
such as My_Project_Shifted.dwg, where the _Shifted indicates the data has been translated to a local 
coordinate space. You will find a sample file called movetozero.scr included the ZIP at this link. If you 
open it up in a text editor, it will look like this: 
expert 5 layer u * t * on *  
move all  
963307.9940',678305.7901' 0,0 
zoom e expert 0 

In this example, the script disables all 
prompts, unlocks, unthaws and turns 
on all layers, selects everything moves 
from a relative point of x: 
963307.9940’ by y: 678305.7901’ to x: 
0 by y: 0. It then zoom extents and 
switches back to display all prompts. 
Since Autocad is a double precision 
application, this translation of the 
CAD data does not result in 
degradation as it did when 3ds max 
translated the data. Here is the same 
CAD file from earlier imported into 3ds max. Notice the model is no longer degraded (Figure 10).  

Figure 10 

https://onedrive.live.com/redir?resid=CEA4BCD8949D6676!363517&authkey=!AE22L2chq79vLT8&ithint=folder%2c
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The process of translating the data back to coordinate space requires a similar script, which I would 
name movefromzero.scr where the translation points are reversed in the following manner: 
expert 5 layer u * t * on *  move all  0,0 963307.9940',678305.7901' zoom e expert 0 

It is important to note, you cannot import a 3ds max file into Autocad or a similar package, but you can 
import an FBX, 3DS, OBJ, DWG and other formats into your respective CAD/Geospatial application via 
the export process in 3ds max. With this method, the single precision application you are using to import 
the CAD data can be 3ds max, Sketchup, Maya, Revit, etc., whichever you require. But the process of 
translation is the same inside Autocad. Also of note, while this script does not function in other CAD and 
geospatial packages such as Microstation or ArcGIS, you can use a DWG workflow for exchanging data.  

For instance, you can open a DGN in Microstation, save as a DWG, open the DWG in Autocad and use 
the script to translate to a local coordinate system. For the process to get the data back, you must 
export to a format which can be read in Autocad, run the movefromzero.scr script to move all the data 
back to coordinate space, save the resulting file and open it in Microstation.  

Method 2 – Create Custom Coordinate System  
This next method is much more involved, but adds additional transformational options to more 
applications. This exercise will generate both an Autodesk based coordinate system as well as a more 
generic PRJ based coordinate system. The Autodesk method works only with other Autodesk 
applications, whereas the PRJ will work with many applications outside of the Autodesk software 
stables.  

Let’s start by first identifying our projection location, determining the appropriate Projection and 
Datum, and establishing a transformation offset point which will point our custom coordinate space 
back to project space. I have provide in the ZIP file located at this link, a text file (MyProjectData.txt) 
with our project references as described above. We will use this data to first create our new False 
Easting and Northing data using the included Excel Spreadsheet called Coordinate Conversion.xlsx. 
Open the Excel file, add the FE and FN values from the text file under Project FE/FN to the excel sheet on 
row 5, add the Offset Origin FT x and y values listed in the text file to row 7 and you will be presented 
with your new custom FE/FN values (Figure 11). Enter these new values into the file MyProjectData.txt 
and save for the next step, where you will use the custom FE/FN values for creating a custom coordinate 
system. 

 

  

https://onedrive.live.com/redir?resid=CEA4BCD8949D6676!363517&authkey=!AE22L2chq79vLT8&ithint=folder%2c


Effective Coordinate Space Transformation Workflows 

 
 12 

 

Now, we need to create our Autodesk based custom coordinate system. This will require either Autocad 
Map 3D or Civil 3D (Map 3D is integrated into Civil 3D). In Map 3D, Click on the “MAP SETUP” tab, select 
“Create” and for the pop-up menu, select “Create Coordinate System”. If you are using Civil 3D, switch 
your UI mode to “Planning and Analysis”, which is the UI for Map 3D and repeat the previous steps for 
Map 3D (Figure 12).  

  

Figure 12 

Figure 11 
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Figure 15 

In the resulting wizard, you will select 
“Create a coordinate system 
definition” and click Next (Figure 13).  

 
 
 
 
 
 
 
 
 
 
 
 
Next, select “Start with a coordinate system” 
and click Next (Figure 14).  
 

 

 

 

 

 

 

Next, select “Create a new 
coordinate system from…” 
and click on the select button 
(Figure 15).  

 

 

 

  

Figure 14 

Figure 13 
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For this example, we will use Colorado State Plane Central US FT HPGN. A quick way to list only the 
Colorado oriented systems is to type Colorado. Select COHPCF from the list (Figure 16). Click the select 
button to select this option and click next to proceed to the next stage. 

 

 

In this next stage, you will need to assign a unique code for your custom coordinate system. In this 
example, I gave it a name unique to my project. It is completely optional to add a description, but I 
would recommend it (Figure 17). Once completed, click next to continue.  

Figure 16 

Figure 17 
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For the next stage, we will input the False Easting and Northing values from the MyProjectData.txt file 
into the appropriate fields (Figure 18). Once complete, click next. 

 

This stage does not require any input unless you need to specify any additional custom information 
(Figure 19). Click next and review your information on the following stage. If this looks correct, select 
Finish. That’s it, you now have your custom coordinate system saved on your system. 

 

  

Figure 18 

Figure 19 
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Sharing 
While the Autodesk method for using coordinate systems is a proprietary system, there are ways to 
export your custom coordinate systems for others to use. First, when you created your custom 
coordinate system you will remember there was a final screen where you could review your options 
before selecting finish. You can get back to this review and expose some additional data which will be 
helpful in creating a PRJ projection file. In Map 3D or Map 3D mode in Civil 3D, go to the MAP SETUP Tab 
and this time select Library (Figure 20). 

In the resulting Coordinate System Library window, locate your custom coordinate system and click the 
“Edit” button at the bottom of the window. This will open a windows where you can review all the 
attributes of your custom coordinate system and even make changes if you require. Go to the “WKT” 
tab and you will see 3 WKT (Well-Known Text Markup Language) definitions for OGC, Oracle and ESRI 
PRJ files (Figure 21). You could highlight the definition for ESRI, copy it, open a text editor, paste the 
contents and save a custom PRJ fie which you can use in other GIS applications such as ArcGIS and 
Global Mapper.   

Figure 20 

Figure 21 



Effective Coordinate Space Transformation Workflows 

 
 17 

 

 
Another method for sharing your custom coordinate system with other Autodesk users is to export and 
XML file, which can then be shared with another user and imported into their system. To initiate this 
process, you will need to open Map 3D or Civil 3D, type the command MAPCSLIBRARYEXPORT, type 
the exact name of your custom coordinate system, hit enter several times until you get a Save dialog 
window. Select where you want the file to reside and click save.  

To import a custom coordinate system, use the MAPCSLIBRARYIMPORT command, type the name of 
the Custom Coordinate System you are importing and hit enter until the process is completed.  

Method 3 
In this example, we will use the custom coordinate system to prepare a point cloud system in Recap for 
import into 3ds max, import an FBX file into an Infraworks model, export a DWG from 3ds max and 
merge into a CAD file and finally prepare a CAD file for attachment to a Revit file and the subsequent 
export and integration into CAD. Finally, I will demonstrate a workflow with Navisworks.  

Recap 
The Recap workflow ultimately requires an existing geospatial coordinate system and a custom 
coordinate system when working with application such as 3ds max. The degradation of double precision 
data also affects the point cloud once imported into 3ds max causing a bizarre display problem with the 
points. If however you apply a geospatial transform in Recap before creating the Recap project, the 
resulting data will import into 3ds max not only in the correct local coordinate space, but will not exhibit 
the same display problems.  

For this workflow, you must have the original point cloud datasets as this will not work with an existing 
RCP or RCS. If all you have is a Recap dataset, you must first export it to a third party format such as LAS 
or PTS, then reimport the dataset to apply the transform. This assumes you are familiar with the Recap 
and 3ds max workflow.  

To begin, launch Recap, 
create a new project and 
import your point cloud 
datasets. You will to access 
the advance options of this 
project, so select the Scan 
options tab and open the 
Advance options. Here is 
where you assign the 
coordinate system for the 
point cloud you are 
importing and the resulting 
coordinate system you 
would like it transformed to 
(Figure 22). Figure 22 
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Once the import process is complete, save your Recap project and import into 3ds max using the point 
cloud object in the creation tab. Make sure you create the point cloud object at 0,0 to ensure it enters in 
the correct location. To ensure this happens, select the point cloud object with the select and move tool, 
hit your F12 key to open your transform palette, and set the position to 0,0,0 in x, y and z. Viola’ it’s 
perfectly aligned to the custom coordinate system and you can begin to use it to build what you will. 
And even better, no wonky bizarre point display problems (Figure 23). 

It is important to note, while this exercise utilized Recap and 3ds max, the workflow is the same for 
Recap and Revit, Recap and Autocad (if you are working in a local system) or Recap and Inventor. 

Figure 23 
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Infraworks 
For this exercise, we will export content 
from InfraWorks as an FBX, import into 
3ds max, build our addition, export an 
FBX and finally import back into 
InfraWorks. This exercise is based on the 
premise you already know how to use 
InfraWorks and 3ds Max. To start, I will 
export an FBX from InfraWorks. Once you 
have selected the area you want to 
export, you will need to select your 
custom coordinate system, set the origin 
to user defined and reset the x, y and z 
values to 0 (you can click the red X to 
reset all of these) (Figure 24).  

  

Figure 24 
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Now, import the model into 3ds max. Before you do this, however, make sure you are working at the 
same scene scale, in this case, feet. Once imported, you will immediately notice it is the local coordinate 
space (Figure 25). Proceed to make your model modifications and export an FBX, which we will import 
into InfraWorks using our custom coordinate system. 

  

Figure 25 
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When you import the 3D model in 
InfraWorks, you must select the custom 
coordinate system which you created 
earlier (Figure 26). That’s it, your model 
should now be in place (Figure 27) 
 

 

 

  

 

 

 

 

 

 

Figure 26 

Figure 27 
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3ds Max 
For this next exercise, we will import CAD into 3ds max, build some content, export a DWG and bring the 
DWG into the project coordinate space. To start, we need to bring our reference CAD into our custom 
coordinate space. Let’s start by creating a CAD file and assigning it our custom coordinate space. Open 
Map 3D or Civil 3D, create a new file using the appropriate unit scale (foot or meters), and use the 
command MAPSCASSIGN to open the Coordinate Space Library. Select your custom coordinate system 
and click Assign. Save your file with the name Project_Local.dwg. You can now use this as your 
translation file.  

Next, you will use the XREF command to open the External References palette and attach your CAD 
file(s). As you attach each file, you will get an Attach External Reference dialog inside which you must 
select the “Locate using Geographic Data” and click ok (Figure 28). This assumes you have assigned your 
project CAD coordinate space information, otherwise this will not work. If you get a warning regarding 
coordinate space changes, click ok.  

Once all of your project CAD has been attached, you will need to bind it all to your file. Once this stage is 
complete, you need to save the resulting file as MyProjectCAD_Shifted.DWG. This will serve as your 
reference once imported into 3ds max. Again, as we did with the InfraWorks exercise, you must make 
sure your project scale is set the same in 3ds Max as it was for your CAD application. Import the DWG 
into 3ds max and model your content. Once this stage is complete, export your content as a DWG and 
open your CAD application. You will need to repeat the same process by assigning your exported DWG 
from 3ds max the custom coordinate system. Once this is complete, you will be able to use the XREF 
command to attach your DWG to the project CAD and use the “Locate using Geographic Data” option in 
the Attach External Reference dialog.  

Figure 28 
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Revit 
The Revit workflow uses a process similar to what was done with 3ds max. Again, you would create a 
blank DWG, assign it your custom coordinates using the MAPCSASSIGN command and save the file. 
Next, use the XREF command to attach your project CAD, use the “Locate using Geographic Data” option 
in the Attach External Reference dialog and finish up by binding the data and saving out a “Shifted” file. 
This shifted DWG will then be inserted into Revit for reference. From here, your CAD is in the local 
coordinate space in Revit.  

When you are ready to export your Revit to coordinate space, all you need to do is export a DWG, open 
it in your CAD application and assign it the custom coordinate using the MAPCSASSIGN command. If you 
are using InfraWorks to import the Revit file, you will use the custom coordinate system in the Data 
Source Configuration dialog, which you saw in the Infraworks exercise.  

Navisworks 
The Naviswork workflow is far simpler and does not require an actual custom coordinate system like the 
other applications, however, it does require your project document, MyProjectData.txt, specifically the 
custom offset value. 

As you export content to an NWC format from your single precision applications such as 3ds max, Revit, 
Inventor, Sketchup, etc., you will need this reference point to ensure your data comes into the correct 
location in Navisworks. You will still need to use one of the transformation methods listed above to 
ensure your reference data comes into your single precision application in the correct location.  

For this exercise, I will export content out of 3ds max as a Navisworks NWC and import into Navisworks. 
Once in Navisworks, you will use the 
offset value in your project file 
(MyProjectData.txt ) to shift the 
imported file into the project correct 
coordinate space. The exercise 
requires basic knowledge of 3ds max 
and Navisworks.   

To start, we will import or reference 
CAD into 3ds max using an already 
shifted file. Next, we create our 
content and export as a Navisworks 
NWC file. For this final stage, you 
import the NWC into Navisworks 
using the “Append” function. To 
shift this file into the correct location 
for the project, you will need to 
open the “Selection Tree” palette, 
right-click on your file, select “Units 
and Transform”, input your offset 
values from the MyProjectData.txt 
file and click OK (Figure 29).  Figure 29 
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Viola, your model data is no in coordinate space! (Figure 30) 

Global Mapper  
I will wrap this up by demonstrating a very robust and relatively inexpensive GIS software solution, 
which has become the backbone of much of our production pipeline. WSP | Parsons Brinckerhoff is an 
engineering services firm with a foot in both civil infrastructures and buildings (horizontal and vertical 
structures). As such, we frequently are building out neighborhoods, towns, cities, states and entire 
regions depending on the needs of the client. Global Mapper has served us well as an aggregator of CAD 
and geospatial datasets and gives us a flexible method for exporting this aggregated content in a 
multitude of formats best suited for our projects.  

Like the Autodesk methods I have demonstrated earlier, we have developed an effective method for 
creating custom coordinate systems which we can use to reproject and exchange datasets using Global 
Mapper. This process requires the creation of a custom coordinate system, but instead of using the 
Autodesk based Coordinate System Wizard, we will create a new “workspace” in Global Mapper, assign 
a project coordinate system and from there, edit a PRJ file with values form our project data text file 
(MyProjectData.txt).  

Figure 30 
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To start, launch Global Mapper, and assign a project coordinate system using the Tools>Configure menu 
option. In the resulting palette, click on the Projection tab and set your project coordinate system 
(Figure 31). 

 

Before you click OK, to take your selection, you will 
need to click on the Save To File button next to the 
Projection listing (Figure 32).  

 

 

 

 

 

 
Figure 32 

Figure 31 
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This will allow you to save a PRJ file to the location 
of your choice. Give it an appropriate name such as 
MyProject_Custom_Coordinate.prj. Next, you will 
need to open the file in a text editing application 
and modify the False Easting and Northing values 
using the information located in your project 
document (MyProjectData.txt). Save the resulting 
file.  

Now, all you need to do to make sure your 
geospatial data exports are reprojected is to open 
the Tools>Configure menu and assign load the 
custom coordinate system using the “Load From 
File” button above the “Save To File” button you 
used earlier. You can also use the custom 
coordinate system to realign your single precision 
data in geospatial space. For instance, if you used 
3ds max to create vector line data and exported 
that as a DWG, you can assign the custom 
coordinate system definition to the DWG when you 
import it into Global Mapper (Figure 33).  

 

 

Conclusion 
You have learned a multitude of different methods for exchanging data between single and double 
precision applications, but it is important to note, there is a common thread between them all. First, 
there is a project document which contains all your raw transformational data. You use the data within 
this document to explain projection, datum and offsets, which is them used to create a custom 
coordinate system(s). These custom coordinate systems are formatted differently from product line to 
product line, but the underlying data is all the same; where is the project and what is the offset.  

Once you create these base systems and files, you have an efficient workflow for exchanging your 
geospatial, CAD and 3d model data throughout the lifecycle of your project. It is my hope these 
transformation workflows are useful and effective in your next project. 

Figure 33 
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